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Important information
WARN ING

l Failure to follow the installation instructions shipped with your SMART product could result in
personal injury and damage to the product whichmay not be covered by your warranty.

l To reduce the risk of fire or electric shock, do not expose the SMART product to rain or
moisture.

l Ensure that any cables extending across the floor to your SMART product are properly
bundled andmarked to avoid a trip hazard.

l Do not open or disassemble the SMART product. You risk electrical shock from the high
voltage inside the casing. Opening the casing also voids your warranty.

l To reduce the risk associated with leaking batteries:

o do not leave the battery in the product for an extended period

o do not heat, disassemble, or short the battery, or expose it to fire or high temperature

o avoid eye and skin contact if batteries have leaked

o dispose of exhausted batteries and product components in accordance with applicable
regulations

l Do not charge the battery with any power adapter other than the one supplied. Do not charge
other battery types in your SMART product with the supplied power adapter. Both of these
actions can cause damage to the product and can cause a fire or personal injury.

l If the SMART product becomes excessively warm or emits an unusual smell while the
battery is recharging, immediately disconnect the power adapter from the power outlet and
turn the product off.

l Do not place items other than your microphone in your microphone charging cradle. Items
can create an electrical short leading to product damage, fire or personal injury.

l Ensure your ceiling or ceiling tiles are strong enough to support the ceiling-mounted product
components and use tethers if provided or required. Failure to securely install components
might lead to components falling which can cause personal injury and product damage that
may not be covered by your warranty. Refer to product documentation to find component
weights.

l Ensure the installation of your SMART product meets local building codes and regulations.
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CAUTION

l Avoid setting up and using the SMART product in an area with excessive levels of dust,
humidity and smoke.

l If your SMART product requires replacement parts, use replacement parts specified by
SMART Technologies or parts with the same characteristics as the original.

l Make sure the electrical socket your SMART product is plugged in to remains easily
accessible during use.

l Do not drop the portable components of your SMART product. Dropping your microphone
can damage it and void the warranty for that item.

l When connecting product components, ensure cables are connected to correct locations.
Incorrectly connected components can result in product damage.

l Do not use your SMART Audio™ classroom amplification system in a facility control system
or any other environment that requires extremely high reliability, or where the use of a
wireless device can cause interference. The product can interfere with other electronic
devices or cause them tomalfunction, or other wireless devices may interfere with the
product or cause it to malfunction. Where use is prohibited, turn off the product. SMART
Technologies does not accept any liability for damages.

I M POR T A N T I N F ORMA T I ON
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About your SMART Audio classroom
amplification system
The SMART Audio system amplifies teacher and student voices, reducing teacher vocal strain and
ensuring that everyone can clearly hear what is being said from anywhere in the room. The systems
include a wireless microphone that either the teacher or students can use, a control unit that provides
a USB interface to the computer and a roommodule that combines an amplifier and an infrared
sensor.

Your SMART Audio system features seamless integration with SMART Notebook™ collaborative
learning software. Pressing the SMART Audio icon in SMART Notebook software brings up an
intuitive user interface that enables educators to control up to five audio inputs with the touch of a
finger. Adjusting the volume is quick and simple, saving valuable class time while maintaining lesson
flow.

You can order the system with ceiling-mounted or wall-mounted speakers.
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Overview of the SMART Audio system
This cabling diagram shows the relationship between all of the components in the SMART Audio
system. For more information on installing and cabling your SMART Audio system, see the
SMART Audio 340 Classroom amplification system Installation guide (smarttech.com/kb/155320).
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Physical components
Your SMART Audio system includes the following:

l Control unit and its power supply

l Microphone, sleeve and lanyard

l Microphone charging cradle and its power supply

l Ceiling-mounted roommodule, infrared sensor and amplifier

l Either four ceiling-mounted speakers or four wall-mounted speakers

Control unit
The control unit is a wall-mounted panel that connects the
SMART Audio system to your computer. For more information on using
the control unit, seeUsing the control unit on page 9.

The SMART Audio 340 system top view
The top of the SMART Audio 340 system includes a Power button.

SMART Audio system bottom view
The underside of the control unit has a removable panel. Under the
panel are the following:

l USB connection to the computer

l RCA connections for auxiliary input devices such as DVD/Blu-
ray players and VCRs

l Connectors for assistive listening devices

l RJ45 connection for the Cat 5e cable to the roommodule

l System power input

l System Reset button
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Room module
The ceiling-mounted roommodule contains the infrared sensor and the
speaker amplifiers. It is connected to all of the speakers and to the
control unit.
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Wall-mounted speakers
The four 30W wall-mounted speakers receive both power and audio
input through speaker wire from the roommodule.
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Ceiling-mounted speakers
The four 30W ceiling-mounted speakers receive both power and audio
input through speaker wire from the roommodule.

Microphone
Your SMART Audio system transmits an infrared signal by line of sight
up to 15' (4.6 m) to a receiver in the roommodule or an expansion
sensor. Themicrophone has power, volume andmute buttons.
You can connect external wiredmicrophones to the 3.5mm jack on the
side of themicrophone.
You can wear it on your belt, hold it in your hands or attach the included
lanyard to themicrophone and then wear it around your neck. You can
also add an auxiliary microphone such as a headset.

Microphone charging cradle
You can charge themicrophone in the wall-mountedmicrophone
charging cradle provided with your SMART Audio system

Optional accessories
Part no. Name Description

CAS-HSMIC SMART Audio system wired
headset microphone

For hands-free operation, you can use an
auxiliary headset microphone or a
lavalieremicrophone that you attach to
your collar, tie or other clothing.

CAS-LVMIC SMART Audio system wired
lavalieremicrophone

CAS-300-IRMIC SMART Audio system wireless
infrared transmitter microphone

You can use a secondmicrophone as a
backup or as a student microphone.

CAS-300-IRSENS SMART Audio system expansion
infrared sensors

You can connect one or two expansion
sensors to the roommodule to increase
audio coverage in a large room, or to fill in
the blind spots. An expansion sensor
includes a 15' (4.5 m) cable.
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Using SMART software
Your SMART Audio system operates without additional software. However, the following software
could extend your usage of the SMART Audio system.

l SMART Audio software enables you to control your SMART Audio system. You can use it
alone or integrated with SMART Notebook software.

l SMART Audio configuration software enables a system administrator to customize the
SMART Audio system settings.

l SMART Notebook software enables you to access commonly used audio settings, such as
volume control, while teaching at your interactive whiteboard.

You can install SMART software from the included CD, or from the software download page
(smarttech.com/downloads).

Choosing audio inputs
You can connect audio inputs from a variety of sources to your SMART Audio system.

Speaking into your microphone
When you speak into your microphone, your voice transmits by infrared signal to the roommodule or
expansion sensors and is broadcast from the speakers. For more information on speaking into the
microphone, seeSpeaking into themicrophone on page 16.

Playing audio files from your computer
You can play audio or video files on your connected computer, and the audio broadcasts from the
speakers.

Connecting an audio input device to your microphone
You can connect an audio input device, such as an auxiliary microphone or portable audio player,
directly to the 3.5mm jack on your microphone. The audio input transmits by infrared signal to the
roommodule or expansion sensors and is broadcast from the speakers. For more information on
connecting an audio input device to your microphone, seeConnecting an auxiliary audio input device
on page 16.

Connecting an audio input device to the control unit
You can connect an audio input device, such as a CD player, DVD/Blu-ray™ player or VCR, to the
control unit. The audio then broadcasts from the speakers.
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Connecting an audio input device to your interactive whiteboard
You can connect an audio input device, such as a CD player, DVD/Blu-ray player or VCR, to your
interactive whiteboard’s External Control Panel (ECP) or Appliance Control Panel (ACP). The audio
then broadcasts from the speakers.

Connecting your paging system to the room module
You can connect your existing paging system to the roommodule. A page then broadcasts from the
speakers. You can configure the system to reduce the volume of all other audio input devices when a
page is broadcast.

Controlling audio inputs
You can use your microphone tomute or adjust volume of your voice, an auxiliary audio input device
or devices connected to the control unit or your interactive whiteboard.

Alternatively, you can use SMART Audio software installed on your computer to control volume.
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Chapter 2: Using the control unit
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The control unit has the following roles in your SMART Audio system:

l Provides power to the roommodule and the speakers through the Cat 5e cable to the room
module

l Connects to your computer for audio adjustments using the SMART Audio software

Turning on or turning off your SMART Audio
system
Your control unit features a Power button that you can use to turn on and turn off your SMART Audio
system, including your roommodule and speakers.

g To turn on or turn off your SMART Audio system

Press thePower button on the control unit.

I MPORTANT

Themicrophone has its own Power button. For more information, see Turning on and turning off the
microphone on page 15.
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Connecting auxiliary audio input devices
You can connect auxiliary audio input devices to the control unit, such as a CD player, DVD/Blu-ray
player, VCR or other media device, and then transmit audio from these devices as an alternative to
speaking into your microphone.

When your SMART Audio system is turned on, you can control the volume andmute features using
the auxiliary input controls, as well as using SMART Audio software, or themicrophone.

g To connect an auxiliary audio input device

1. Ensure that the audio input device is turned off.

2. Remove the bottom cover from the control unit.

3. Connect two RCA input cables from your audio input device to theAux 2 inputs.

4. Replace the cover on the control unit.
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Introduction
Yourmicrophone uses a line of sight infrared signal to transmit your voice to the roommodule or an
expansion sensor. Themaximum distance for this is 15' (4.6 m).

You can recharge themicrophone’s batteries using the included charging cradle.

Assembling the microphone
Yourmicrophone has a battery, a protective sleeve and a lanyard.

g To start using your microphone:

1. Install the battery in themicrophone (see Installing or replacing themicrophone battery on the
next page).

2. Slide themicrophone into the protective sleeve.

3. Connect the lanyard to themicrophone, if desired (seeConnecting the lanyard to the
microphone on the next page).

4. Charge themicrophone by placing themicrophone in the charging cradle (seeCharging the
microphone on page 14).

5. Turn on themicrophone (see Turning on and turning off themicrophone on page 15).

6. Connect themicrophone to the roommodule (seeConnecting themicrophone to the room
module on page 15).

7. Adjust the volume (seeSpeaking into themicrophone on page 16).
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You can add an auxiliary microphone such as a headset, and you can connect an external audio
source, such as a handheld audio player, to your microphone. You can also use a secondmicrophone
to pass around the class.

Installing or replacing themicrophone battery
Themicrophone uses a replaceable, rechargeable 3.7V lithium ion battery.

g To place or replace a battery in the microphone

1. Remove the back panel of themicrophone.

2. Remove the old battery, if required.

3. Remove the plastic film from the replacement battery.

4. Insert the replacement battery into themicrophone with the label facing out and down.

5. Replace the back panel.

Using themicrophone’s protective sleeve
Themicrophone has a protective sleeve. Slide themicrophone into the sleeve to reduce audio
transfer from tapping themicrophone and to protect themicrophone from damage.

NOTE

Themicrophone is more stable if it is charged in its protective sleeve.

Connecting the lanyard to themicrophone
Themicrophone has a lanyard for hands-free use.

g To connect the lanyard to the microphone

Slide the lanyardmounting plate into the back of themicrophone.

CHA PT ER 3
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Charging the microphone
You can charge themicrophone in themicrophone charging cradle or by connecting the included
AC power adapter's plug directly to the bottom of themicrophone. It takes approximately one hour to
charge themicrophone.

A full charge provides approximately seven hours of use depending on how frequently you use the
microphone, the battery's age and the room temperature.

WARN ING

l Do not charge the battery with any power adapter other than the one supplied. Do not charge
other battery types in your SMART product with the supplied power adapter. These actions
can cause damage to the product and can cause a fire or personal injury.

l If the SMART product becomes excessively warm or emits an unusual smell while the
battery is charging, immediately disconnect the power adapter from the power outlet and turn
off the product.

NOTE

Themicrophone is more stable if it is charged in its protective sleeve. For more information, see
Using themicrophone’s protective sleeve on the previous page.

g To charge the microphone in the microphone charging cradle

1. Connect the AC power adapter to themicrophone charging
cradle.

2. Place themicrophone in the charger facing out.

The red light flashes when themicrophone is charging, and
turns solid red when themicrophone is fully charged.
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Turning on and turning off the microphone

g To turn on the microphone

Press any button on themicrophone.

Themicrophone status light flashes red, and then turns solid green.

I MPORTANT

If you do not see a light or you see an amber light, see Troubleshooting using themicrophone status
light on page 47.

g To turn off the microphone

Press theMute/Power Off button for four seconds.

Themicrophone status light turns off.

T I P

You can set your microphone to turn off automatically when you place it in themicrophone charging
cradle, and to turn on when you remove it. For more information, seeCustomizing your microphone
on page 19.

Connecting the microphone to the roommodule
When your microphone is connected to the roommodule or an expansion sensor, the status light is
solid green. If the status light is amber or flashing red, themicrophone isn’t connected.

g To connect the microphone to the room module

1. Stand within 15' (4.6 m) of the roommodule or an expansion sensor.

2. Point themicrophone’s infrared transmitter at the roommodule or an expansion sensor.

3. Press theMute/Power off button for four seconds to turn off themicrophone.

4. Press any button to turn it on again.
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Speaking into the microphone
Yourmicrophone transmits your voice up to 15' (4.6 m) to the roommodule or an expansion sensor.

I MPORTANT

l Hold your microphone so the infrared transmitter faces out.

l If you hear a static sound suddenly, themicrophone is either out of range or is pointed against
a non-reflective surface. Position your microphone so the infrared transmitter points toward
the roommodule or an expansion sensor.

Adjustingmicrophone volume
You can increase or decrease the volume of transmission from themicrophone, as well as mute and
restore volume.

g To increase or decrease the microphone volume

Press theVolume Up orVolume Down button.

g To mute or restore the microphone volume

Press theMute/Power Off button.

When youmute themicrophone, themicrophone status light flashes green. When you restore
themicrophone volume, themicrophone status light turns solid green.

Connecting an auxiliary
microphone
Yourmicrophone doesn’t require an external auxiliary microphone.
However, if you prefer, you can use an auxiliary microphone, such as a
wired headset or a lavalieremicrophone, for hands-free use.

g To connect an auxiliary microphone

Connect the auxiliary microphone to the 3.5mm jack on the side of themicrophone.

Connecting an auxiliary audio input device
You can also connect an external audio input device, such as a handheld audio player, to your
microphone.
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Use themicrophone buttons to adjust the volume of the device that you connected and then you can
speak over the device.

g To connect an auxiliary audio input device

1. Turn on the audio input device, and then reduce the volume on the
device.

2. Connect the audio input device output plug to themicrophone’s
3.5mm auxiliary input jack.

3. Increase the volume on the audio input device until the audio input
device is clearly and comfortably heard over the SMART Audio
system.

g To mute or restore volume for an auxiliary audio input device

Press theMute/Power Off button on themicrophone.

The audio input from the device is muted or restored, and the volume of your voice remains the
same.

Controlling an auxiliary audio input device from
your microphone
You can use themicrophone to increase and lower the volume ormute themost recently active audio
input device connected to the control unit.

This enables you to decrease or mute the volume, provide commentary, and then return to
transmitting audio without returning to your computer or the audio input device.

g To increase or decrease the volume of an auxiliary audio input device

1. Press theMute/Power Off button on your microphone so that your voice doesn’t transmit.

Themicrophone status light flashes green.

2. Adjust the volume of the device connected to the control unit using the volume control buttons
on themicrophone.

T I P

Youmust press a volume button several times before you notice a difference.
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g To mute or restore the volume to an auxiliary audio input device

Press theSoft button on your microphone.

The audio input from the device is muted or restored, and the volume of your voice remains the
same.

Using a second microphone
You can purchase a second infraredmicrophone as a back-up or to use as a secondmicrophone. For
example, a teacher can use the primary microphone and the students can pass around a second
microphone.

T I P

You can set the student microphone so students can’t adjust the volume on their microphone or on
any auxiliary audio input devices. For more information, seeSetting your microphone to disable
volume buttons on page 20.

Setting up a secondmicrophone
The SMART Audio systemmicrophone can transmit on two channels: channel 1 and channel 2.
When you connect a secondmicrophone, youmust set it to use the unused channel.

Your microphonemode determines how to set your secondmicrophone to an unused channel.

l In Find Channel mode (default), themicrophone chooses an available channel.

l In Assigned Channel mode, themicrophone transmits on the channel you assign it.

In Assigned Channel mode, you can set amicrophone to transmit on either channel 1 or channel 2.

g To check the microphone mode

1. If themicrophone is turned on, turn it off by pressing theMute/Power Off button for four
seconds.

2. Turn on themicrophone by pressing any button.

3. Observe themicrophone status light.

If themicrophone status light flashes red once, themicrophone is set to Assigned Channel
mode and channel 1.

If themicrophone status light flashes red twice, themicrophone is set to Assigned Channel
mode and channel 2.
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g To set a microphone to Assigned Channel mode

1. Turn off themicrophone by pressing theMute/Power Off button for four seconds, and then wait
10 seconds.

2. Press theSoft button and theMute/Power Off button for three seconds, and then release the
buttons.

Themicrophone status light flashes red rapidly.

3. If you want to set themicrophone to channel 1, press theSoft button.

If you want to set themicrophone to channel 2, press theVolume Up button.

Themicrophone status light turns solid green.

Customizing your microphone
You can customize your microphone to change some of its settings. For example, you can set your
microphone to do the following:

l Only theMute/Power Off button works and students are unable to adjust the volumewhile you
pass themicrophone around.

l Themicrophone turns off when you place it in a charger and turns on when you remove it.
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Setting your microphone to disable volume buttons
You can disable all of the buttons except theMute/Power Off button. When disabled, students are
unable to adjust the volumewhile you pass themicrophone around.

g To set your microphone to disable the volume buttons

1. Turn on themicrophone.

2. Press theSoft button and theVolume Down button for five seconds.

Themicrophone status light flashes red, yellow and green alternately indicating that you’re in
Local Programmingmode.

3. Press theMute/Power Off button for one second to change the state of the Button Disable
mode.

I MPORTANT

o Four quick green flashes of themicrophone status light indicates that the feature is on
and only themute button works.

o Four quick red flashes of themicrophone status light indicates that the feature is off
and all buttons work.

4. Press theSoft button and the Volume Down button for three seconds to exit Local
Programmingmode.

OR

Wait 30 seconds and themicrophone automatically exits Local Programmingmode.
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Enabling automatic shut off when charging
You can set your microphone to automatically turn off when you place it in themicrophone charging
cradle and to turn on when you remove it.

g To enable automatic shut off when charging

1. Turn on themicrophone.

2. Press theSoft button andVolume Down button for five seconds.

Themicrophone status light flashes red, yellow and green alternately indicating that you’re now
in Local Programmingmode.

3. Press theVolume Down button to change the state for themicrophone Automatic On and
Automatic Off mode.

I MPORTANT

o Four quick green flashes of themicrophone status light indicates that the feature is on
and themicrophone turns off when in the charger and turns on when removed.

o Four quick red flashes of the light indicates that the feature is off and youmust turn on
or off themicrophonemanually.

4. Press theSoft button andVolume Down button for three seconds to exit Local Programming
mode.

OR

Wait 30 seconds and themicrophone automatically exits Local Programmingmode.
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About using SMART software
You can use SMART Notebook collaborative learning software to conveniently control your
SMART Audio system from your interactive whiteboard.

After you install SMART Audio software and integrate it with your SMART Notebook software you

can then press theSMART Audio icon on the SMART Notebook software toolbar, to do the
following:

l Adjust the volume of up to twomicrophones.

l Mute or adjust the volume of audio files playing on your computer.

l Mute or adjust the volume of audio files playing on connected audio input devices.

l Mute all your audio input devices.

l Adjust the brightness of the speaker tone.
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Installing SMART Audio software
Install SMART Audio software from the included CD, or go to the download page
(smarttech.com/downloads).

g To install SMART Audio software (Windows computers)

1. Disconnect the USB cable that connects your computer to your control unit.

2. Insert the included CD in your computer, and then browse to theSMARTAudioSetup.exe file.

You can also go to the download page (smarttech.com/downloads), select the SMART Audio
software downloads, and then downloadSMARTAudioSetup.exe to your desktop.

3. Double-click theSMARTAudioSetup.exe file, and then follow the on-screen instructions.

g To install SMART Audio software (Mac computers)

1. Disconnect the USB cable that connects your computer to your control unit.

2. Insert the included CD in your computer, and then browse to theSMART Audio Install.dmg
file.

You can also go to the download page (smarttech.com/downloads), select the SMART Audio
software downloads, and then downloadSMART Audio Install.dmg to your desktop.

3. Double-click theSMART Audio Install.dmg file, and then follow the on-screen instructions.

Integrating SMART Audio software with
SMART Notebook software
If you don’t see the SMART Audio icon on your SMART Notebook software toolbar, you can add it
to integrate SMART Audio software with SMART Notebook software.

g To integrate SMART Audio software with SMART Notebook software

1. Start SMART Notebook software, and then select View > Customize Toolbar.

TheCustomize Toolbar window appears.

2. Drag theSMART Audio icon to your SMART Notebook software toolbar.

3. Press Done.
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Starting SMART Audio software
You can start SMART Audio software by selectingSMART Audio 2011 from the Start menu
(Windows computers) or the Dock (Mac computers).

Alternatively, if you placed the SMART Audio icon in SMART Notebook software, you can use the
icon to start SMART Audio software.

g To start SMART Audio software from SMART Notebook software

1. Start SMART Notebook software, and then press theSMART Audio icon on the toolbar.

SMART Audio software appears.

2. Press Connect.

Changing your SMART Audio system settings
Your SMART Audio system settings enable you to adjust input volumes, check your microphone
battery level and adjust the brightness of the speaker tone.

Adjusting the volume
Your SMART Audio systemmixes all audio inputs from the following sources:

Audio source Description
Aux 1 The connection from your SMART projector to the control unit, that streams any

audio inputs connected directly to your interactive whiteboard
Aux 2 The connection from any audio input device to the control unit
USB Audio Audio or video files playing on the computer and transmitted to the control unit

through the USB connection
Mic 1 The default microphone channel
Mic 2 Secondary microphone channel

T I P

You can rename Aux 1, Aux 2 or USB Audio to a termmore descriptive of the audio input. For more
information, seeChanging the audio input names and trims on page 42.

You can adjust the volume of any audio input. You can alsomute any or all of the inputs, and then
restore their volume later.
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T I P

You can also adjust the volume of inputs at the input source. To adjust the input from the
SMART Audio systemmicrophone, seeControlling an auxiliary audio input device from your
microphone on page 17.

g To adjust the volume of an auxiliary audio input device

1. Press theSMART Audio icon on the SMART Notebook software toolbar.

SMART Audio software appears.

2. Slide the input’s volume slider up or down for the input.

g To mute an auxiliary audio input device

Start SMART Audio software, and then press the un-muted speaker icon below the input
volume slider.

g To restore an auxiliary audio input device’s volume

Start SMART Audio software, and then press themuted speaker icon below the input
volume slider.

Adjusting the speaker tone
The SMART Audio system enables you to adjust the brightness of the speaker tone.

g To adjust the brightness of the speaker tone

1. Press theSMART Audio icon on the SMART Notebook software toolbar.

SMART Audio software appears.

2. Locate theSpeaker Tone area.

3. Press High,Medium or Low.

Checking your microphone battery level
You can use SMART Audio software to check your microphone battery level.

NOTE

If your microphone battery level is below 10%, themicrophone status light flashes red. For more
information, see Troubleshooting using themicrophone status light on page 47.
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g To check microphone battery levels

1. Press theSMART Audio icon on the SMART Notebook software toolbar.

SMART Audio software appears.

2. Locate theMicrophone Battery area.

I MPORTANT

If this area indicates Nomic found, your microphone is either not turned on (see Turning on
and turning off themicrophone on page 15) or not connected to the roommodule or an
expansionmodule.
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You can use your SMART Audio system once you install it without any special settings.

However, a system administrator can install and use SMART Audio configuration software to
customize settings tomeet requirements and to improve your audio experience.

I MPORTANT

Do not install SMART Audio configuration software on teacher computers unless you want to give
them access to the configuration settings.

Teachers should access SMART Audio software from theStartmenu (Windows computers) or the
Dock (Mac computers) or from SMART Notebook software.

Installing SMART Audio configuration software
Install SMART Audio configuration software from the included CD, or go to the download page
(smarttech.com/downloads).

I MPORTANT

You require a computer with aWindows operating system to install and run SMART Audio
configuration software. After you configure your SMART Audio system, you can download the
configuration file to your control unit, and then copy the settings in SMART Audio software from a
computer with either aWindows operating system or aMac operating system software.

g To install SMART Audio configuration software

1. Disconnect the USB cable that connects yourWindows computer to your control unit.

2. Insert the included CD in your computer, and then browse to the
SMARTAudioConfigSetup.exe file.

You can also go to the administrator downloads page
(smarttech.com/AdministratorDownloads), select SMART Audio Configuration software,
and then download theSMARTAudioConfigSetup.exe file to your desktop.

3. Double-click theSMARTAudioConfigSetup.exe file, and then follow the on-screen
instructions.
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Using SMART Audio configuration files
The SMART Audio configuration files includemany settings that affect the operation of your
SMART Audio system. These files are stored in the control unit as LPT files, but you can also store
them on a computer or on a USB drive as a backup.

You can edit an LPT file using SMART Audio configuration software. Access a file in one of the
following ways:

l Start SMART Audio configuration software in yourWindows computer to see the default
settings in a file. For more information, seeOpening a configuration file on the next page.

l Start SMART Audio configuration software in yourWindows computer connected to a control
unit, and then download the control unit’s LPT file to the computer. For more information, see
Downloading a configuration file on the next page.

l Open an LPT file on aWindows computer or USB drive. For more information, seeOpening a
configuration file on the next page.

You can then edit the following audio settings in the LPT file.

l System volume (seeSetting the volume on page 33)

l Speaker controls (seeSpeaker control settings on page 34)

l Paging control and 6-12V input settings (seeSetting the response to a page on page 37)

l Microphone settings (seeSettingmicrophone features on page 39)

l Auxiliary audio input device names and trims (seeChanging the audio input names and trims
on page 42)

l To edit other system settings, seeOther system settings on page 42.

After you edit the LPT file, you can do one of the following:

l Upload the settings to a connected control unit. For more information, seeUploading a
configuration file on page 33.

l Save the settings as an LPT file to upload to a control unit at another time. For more
information, seeSaving a configuration file on page 33.
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Opening a configuration file
You can open a configuration file with SMART Audio configuration software, and then upload it to a
connected control unit. This could be part of implementing settings or restoring a backup of settings.

g To open a configuration file

1. Select Start > All Programs > SMART Technologies > SMART Tools.

2. Click Audio Configuration Software.

TheSMART Audio Configuration Software screen appears.

I MPORTANT

If theWindows operating system does not see a SMART device, a warning appears.
Connect your computer to a SMART Audio system control unit with a USB cable.

3. Select File > Open.

4. Browse to and select the LPT file.

SMART Audio configuration software settings are loaded from the file.

Downloading a configuration file
You can download the configuration file from the control unit to yourWindows computer to do one of
the following:

l Configure specific settings

l Store a backup of the control unit’s settings

l Copy the specific settings, and then upload them to another control unit in another room

g To download a configuration file

1. Start SMART Audio configuration software, and then click Download Configuration File
from CU on theSetup tab.

The file downloads from the control unit to your computer.

2. Edit the file, if you desire.

3. Select File > Save to save the configuration file to your computer.
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Uploading a configuration file
After you edit the settings, you can upload the configuration file to the control unit or to another control
unit in another room.

g To upload configurations to the control unit

1.1. Start SMART Audio configuration software, and then select theSetup tab.

2. Click theUpload Configuration File to the CU button.

SMART Audio configuration software settings are uploaded from your computer to the control
unit.

Saving a configuration file
After you edit your settings, you can save the configuration file to your computer as a backup or to
upload to another SMART Audio system control unit.

g To save a configuration file

1. Start SMART Audio configuration software, and then select the File > Save or File > Save
as.

2. Type a file name, and then click OK.

SMART Audio software settings are saved to the file.

Setting the volume
TheVolume tab enables you to do the following:

l Set amaster default volume for all audio input devices.

l Set specific default volumes for specific audio input devices.

You can set an auxiliary input volume from -30 dB to 8 dB. You can set microphone volumes from -40
dB to 6 dB.

Other volume controls are based on these settings.

g To set the master default volume

Move theMaster slider on the Volume tab up or down.

OR

Change the volume by moving the up or down arrow.
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g To set the default volume of an auxiliary input device

Move theAux-1, Aux-2 or USB Audio slider on theVolume tab up or down.

OR

Move the up or down arrow to change the volume.

NOTE

You can give these inputs more descriptive names, such as "CD player," using
SMART Audio configuration software. For more information, seeChanging the audio input
names and trims on page 42.

g To set the default microphone volume

Move theMic 1 orMic 2 slider on theVolume tab up or down.

OR

Move the up or down arrow to change the volume.

I MPORTANT

Youmust have amicrophone turned on, set to the channel and connected to the room
module to set input volume. For more information, seeUsing a secondmicrophone on page
18.

NOTE

Mic 1 controls the volume for channel 1 andMic 2 controls the volume for channel 2.

Speaker control settings
TheSpeaker Control tab enables you to do the following:

l Select speaker and room equalization settings for the speakers connected to the roommodule
and for the audio characteristics of the room.

l Trim the amplifiers (speakers).

l Save room-specific equalizations.

T I P

All settings in this tab can be saved as an equalization group in the LPT file. This enables you to
save different rooms’ equalization settings in one LPT file. For more information, seeSaving and
recalling equalization settings on page 36.
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Setting speaker and room equalization
Your SMART Audio system has two independent equalization circuits:

l Speaker equalization is a set of equalization curves for industry standard speakers.

T I P

TheSMART Audio Room Speaker library is part of the firmware and can be updated.

l Room equalization consists of seven bands of parametric equalization. It’s helpful when you
have room-specific anomalies, such as bass buildup, ringing or areas of feedback.

NOTE

To select the filter type or other parametric settings, use theRoom Equalization Parameters
menu.

g To set speaker equalization

Select your speaker in theSpeaker EQ drop-down list on theSpeaker Control tab.

If your speaker type isn’t listed, select Flat.

g To set room equalization

Raise or lower the slider on theSpeaker Control tab for each band in theRoom Equalization
area.

OR

Raise or lower the up and down arrows on the Level box.

For bands 2 to 6 you can select the type of filter (Peak, Notch, High Pass and Low Shelf), the center
frequency and the bandwidth of the equalization curve.

g To set room equalization parameters

Set the Filter Type, Frequency andBandwidth for each band on theSpeaker Control tab.

NOTE

You can also set the frequency for band 1 (bass) and band 7 (treble).
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Setting amplifier trim
If a speaker is too loud or too quiet for a portion of the room, you can adjust the speaker trim from -12
dB to 6 dB in 1 dB increments.

NOTE

Adjusting the trim too high can cause feedback.

g To set amplifier trim

Use the up and down arrows in theAmplifier Trims area on theSpeaker Control tab to adjust
the trim.

NOTE

The default setting is 0 dB.

Saving and recalling equalization settings
You can save equalization settings in the roommodule to enable you to respond to different situations
in the same SMART Audio system installation or to save several rooms’ equalization settings in the
same LPT file, and then later apply them to each individual room.

g To save equalization settings

1. Create your equalization settings on theSpeaker Control tab.

2. Select the name you prefer for the current equalization from theSave EQ drop-down list.

3. Click theSave Selected EQ button.

g To recall equalization settings

Select an equalization from theRecall EQ drop-down list on theSpeaker Control tab.
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Setting the response to a page
You can use SMART Audio configuration software to define how your SMART Audio system
responds to an incoming page.

WARN ING

Paging systems often deliver important safety information. Have a professional installer connect
the roommodule to an existing paging system so that pages are heard reliably.

When you install your roommodule, you can connect it to your existing paging system with either a
paging input or a 6-12V connection.

ThePaging tab enables you to do the following:

l Set paging input trim to your roommodule.

l Lower the volume of the current audio to the SMART Audio system when a page is broadcast.

l Lower the volume on a 6-12V input so that when a page is broadcast at the 6-12V input, the
volume of the current audio lowers automatically.

Setting page volume
You can connect your existing paging system to your roommodule, and then set the incoming page
volume. The following are common scenarios:

l Trim the incoming page to -19 dB so that the page doesn’t play over your SMART Audio
system speakers, because it uses other speakers in the room. You can still use the Page
ducking feature for other SMART Audio system inputs. For more information, seeSetting the
volume during a page on the next page.

l Trim to increase or decrease the volume of the page that plays over your SMART Audio
system speakers.

g To increase or decrease the volume of a page

Use thePaging Input Trim arrow buttons on thePaging tab to adjust the page input trim from
-19 dB to 6 dB.
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Setting the volume during a page
For an external page to duck the SMART Audio system, the roommodule requires one of the
following:

l An audio signal at the paging input (even if the page plays on speakers that aren’t part of the
SMART Audio system)

l A signal at the 6–12V input. This is only a signal and doesn’t result in the page playing over the
SMART Audio system.

When a signal is present at the paging input, the volume of the other SMART Audio system inputs is
automatically lowered the designated amount.

g To set the speaker volume during a page

Select a ducking level in theDuck on Page drop-down list on thePaging tab.

Ducking level Volume change during a paging input
none No change
low -6 dB
medium -12 dB
high -18 dB

Setting the volume during a 6-12V input
When you apply a signal to the 6-12V input, the volume of the other SMART Audio system inputs
lowers the designated amount.

g To set the speaker volume during a 6-12V input

Select a ducking level in theDuck on 6-12v drop-down list on thePaging tab.

Ducking level Volume change during a 6-12V input
none No change
low -6 dB
medium -12 dB
high -18 dB
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Setting microphone features
TheMicrophones tab enables you to do the following:

l Set a low battery microphone status light indicator.

l Enable automatic shut off when charging.

l Disable the buttons on themicrophone.

l Enable auxiliary audio input device volume control from themicrophone.

l Enable you to reduce the volume of audio input devices at the control unit when you are
speaking into themicrophone.

l Designate a response for quickly pressing the Soft button.

l Designate a response for pressing and holding the Soft button.

I MPORTANT

After you use SMART Audio configuration software to upload themicrophone settings to a control
unit, youmust download them from the control unit to eachmicrophone by pressing theVolume
Up andVolume Down buttons for four seconds.

Setting the low battery indication
By default, themicrophone status light doesn’t flash to indicate a low battery. You can program the
microphone status light to flash when the battery is low.

l At 10% battery charge the light flashes red twice per second.

l At 5% battery charge the light flashes red four times per second.

g To set the low battery indication light to flash

Select Low battery LED indicator on theMicrophones tab.
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Setting themicrophones to turn off when charging
Automatic On and Automatic Off mode turns off microphones when they’re placed in themicrophone
charging cradle and turns them onwhen they’re removed.

NOTE

This is a global setting for all microphones in the system. You can also program a specific
microphone for a specific response. For more information, seeEnabling automatic shut off when
charging on page 21.

g To set the microphones to turn off in the charging cradle

Select Auto off when charging on theMicrophones tab.

Setting Button Disablemode
Button Disablemode disables the buttons of themicrophone, preventing users from changing volume
settings. TheMute/Power Off button isn’t disabled with this feature.

NOTE

This is a global setting for all microphones in the system. You can also program a specific
microphone for a specific response. For more information, seeSetting your microphone to disable
volume buttons on page 20.

g To disable the buttons on the microphone

Select Disable buttons on microphone on theMicrophones tab.

Setting auxiliary volume control from themicrophone
You can set auxiliary volume control to use themicrophone to increase the volume, decrease the
volume ormute themost recently active auxiliary audio input device at the control unit without
returning to your computer or the input device. For more information, seeControlling an auxiliary audio
input device from your microphone on page 17.

You can then press theMute/Power Off button on themicrophone to take control of the volume for
the audio input device.

NOTE

Auxiliary audio input refers to external input sources at the control unit, not at themicrophone.
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g To set auxiliary audio input volume

If you want to prevent the user from using themicrophone to control input volumes, select
Disable buttons on microphone on theMicrophones tab.

If you want to enable the user to use themicrophone to control input volumewhen the
microphone is muted, select On mute in theAux VolumeControl drop-down list on the
Microphones tab.

Setting auxiliary ducking
The auxiliary ducking settings enables you to reduce the volume of the control unit’s auxiliary audio
inputs when you’re speaking into themicrophone.

This is helpful if you want to talk over a DVD/Blu-ray or other audio input device at the control unit.

g To set an auxiliary ducking level

Select a ducking level in theAux Ducking drop-down list on theMicrophones tab.

Ducking level Volume change during microphone transmission
none No change
low -6 dB
medium -12 dB
high -18 dB

Setting a Soft button short response
You can designate a response for when a user presses theSoft button on amicrophone for less than
four seconds. Typically you can use this to mute auxiliary audio inputs but it can trigger a relay or
have no action.

g To set a Soft button short response

If you want to mute auxiliary audio inputs at the control unit, select Aux Mute in theSoft Button
- Short drop-down list on theMicrophones tab.

If you want to trigger a relay in the relay input, select Relay.

If you don’t want a response when you quickly press theSoft button, select No Action.
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Setting a Soft button long response
You can designate a response for when a user presses theSoft button on amicrophone for longer
than four seconds. Typically you can use this to mute auxiliary audio inputs but it can also trigger a
relay or have no action.

g To set a Soft button long response

If you want to mute auxiliary audio inputs at the control unit, select Aux Mute in theSoft Button
- Long drop-down list on theMicrophones tab.

If you want to trigger a relay in the relay input, select Relay.

If you don’t want a response when you press theSoft button for longer than four seconds,
select No Action.

Changing the audio input names and trims
The Input Names/Trims tab enables you to do the following:

l Change the name of any audio input at the control unit so that it’s more recognizable in
SMART Audio configuration software. Each input can be named from one of the preset input
labels or can be user defined.

l Trim the audio inputs that arrive at the control unit to reduce their volume.

g To change the name of an auxiliary audio input device

1. Identify the input you want to rename on the Input Names/Trims tab.

2. Select the name you want for that input from the drop-down list. You can also select User
Defined, and then type a name for the input device.

g To change the trim of an auxiliary audio input device

Select the input you want to trim on the Input Names/Trims tab, and then set the trim.

Other system settings
TheSystem Settings tab enables you to do the following:

l Change the volume of the active input device at themicrophone.

l Set a response for the roommodule relay.

l Set a trigger for the roommodule relay.
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Enabling themicrophone user to change active input device volume
When your SMART Audio system is set toAuto Select, the control unit automatically detects the
active audio input. This enables themicrophone user to change the volume of the active audio input
device without changing the volume of the other audio input device.

For more information on changing the volume of the audio input devices with themicrophone, see
Controlling an auxiliary audio input device from your microphone on page 17.

g To enable a microphone user to change the volume of audio input devices

If you want to enable themicrophone user to only change the volume of the active audio input
device, select Auto Select on theSystem Settings tab.

If you want to enable themicrophone user to change the volume of all audio input devices, clear
Auto Select.

Setting the relay settings
You can install a relay at the roommodule to trigger a relay response on command, such as dimming
lights, turning on an auxiliary audio input device or sending a signal to another location.

The command to the relay trigger can be one of the following:

l A teacher pressing theSoft button of themicrophone

l An input at the 6-12V input

l Either the teacher pressing theSoft button or by an input at the 6-12V input

The relay can provide one of the following:

l Latching response

l 200ms pulse

l 400ms pulse

l 600ms pulse

This is a single pole, double throw (SPDT) relay with normally open (N.O.), normally closed (N.C.)
and common (COM) contacts.

A relay can be in an activated or deactivated state, as shown below.

State Relay path
Activated The N.O. contact is closed and the N.C. contact is open.
Deactivated The N.O. contact is open and the N.C. contact is closed.
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Room module connections
The roommodule includes relevant connections.

g To set the relay settings

Select the preferredmode on theSystem Settings tab from the following table:

Setting Result
Latching Relay is active until the next pulse is received.
200ms pulse Relay is active for 200milliseconds.
400ms pulse Relay is active for 400milliseconds.
600ms pulse Relay is active for 600milliseconds.

g To set the relay trigger

If you want both the Soft button and the 6-12V input to trigger the relay, select either on the
System Settings tab.

If you want the Soft button to trigger the relay, selectmic.

If you want the 6-12V input to trigger the relay, select 6–12v.

NOTE

If you select 6-12V input as a relay trigger, the input can also set duck audio volume on the
same signal. For more information, seeSetting the volume during a 6-12V input on page 38.
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Chapter 6: Troubleshooting your
SMART Audio system
Resetting your system 45
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Troubleshooting issues with an auxiliary audio input device 48

Youmight be able to solve the issue with your SMART Audio system by performing these checks.

l Check your cable connections.

l Ensure SMART Audio software is installed.

l Reset the control unit to its startup state (see below).

l Update the control unit firmware.

Resetting your system

g To reset the system

1. Remove the control unit bottom cover.

2. Press the labeled system Reset button for three seconds.

The system resets.

3. Replace the control unit bottom cover.
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Updating the control unit firmware
I MPORTANT

Do not update the control unit firmware unless you’re advised to by SMART Support
(smarttech.com/support).

g To update the control unit firmware

1. Launch the SMART Firmware Update.

OnWindows 64-bit operating systems, browse toC:\Program Files (x86)\SMART
Technologies\SMART Product Drivers\SMARTFirmwareUpdater.exe

OnWindows 32-bit operating systems, browse toC:\Program Files\SMART
Technologies\SMART Product Drivers\SMARTFirmwareUpdater.exe

OnMac operating system software, browse toApplications\SMARTProduct
Drivers\Additional Tools\SMARTFirmwareUpdater.app

TheSMART Firmware UpgradeWizard appears.

2. Click Next.

The wizard scans your computer and displays a list of connected SMART interactive products.

3. Select your SMART product in the product update list.

4. Click Next.

The updater updates your firmware.

I MPORTANT

Do not disconnect your control unit from your computer during the update.

5. Click Finishwhen the update is complete, and then orient your interactive whiteboard.
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Troubleshooting using the microphone status
light
The normal state for themicrophone status light is solid green. Use the following table if the light isn’t
on or if it isn’t solid green.

The microphone status
light is...

Cause Solution

Off. Your microphone is turned off. Press any button on your
microphone.

Your microphone battery isn’t
charged.

Charge your microphone battery in
themicrophone charging cradle.

Flashing red twice per
second.

Battery power is at 10% of its full
charge.

Charge the battery.

Flashing red four times per
second.

Battery power is at 5% of its full
charge.

Charge the battery.

Solid amber. Your roommodule isn’t receiving
power.

Press thePower button on the
control unit.

You’re out of range of your room
module.

Move within 15' (4.6 m) of the room
module or the expansion sensor.

Flashing green. Themicrophone is muted. Press theMute/Power Off button
to restore themicrophone’s
volume.

Solid green. Normal operation No action required

CHA PT ER 6

Troubleshooting your SMART Audio system

47



Troubleshooting why your voice doesn’t come
through the speakers
Use the following table if your voice doesn’t come through the speakers when you speak into the
microphone.

Cause Solution

Your volume is too low on the
microphone.

Increase the volume.

Your microphone volume is too low in
SMART Audio software.

Increase the volume using SMART Audio software.

Your microphone isn’t communicating
with the roommodule.

Turn your microphone toward the roommodule or an
expansion sensor, and thenmove to within 15' (4.6 m) of
the roommodule.

The SMART Audio system is turned
off.

Turn on the SMART Audio system.

Twomicrophones are set to the same
channels.

Check themicrophonemode, and then change one
microphone to Find Channel mode.

Troubleshooting issues with an auxiliary audio
input device
Use the following table if you can’t hear an auxiliary audio input device playing on your SMART Audio
system.

Cause Solution
The file isn’t playing. Play the file.
Your computer audio output is muted. Restore the volume for your computer.
The input device is muted at your
control unit.

Increase the volume using SMART Audio software .

The SMART Audio system is turned
off.

Turn on the SMART Audio system.

There is no USB connection from your
computer to the control unit.

Connect a USB cable from your computer to the control
unit.
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Appendix A: Hardware environmental
compliance
SMART Technologies supports global efforts to ensure that electronic equipment is manufactured,
sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment
regulations (WEEE directive)
Waste Electrical and Electronic Equipment regulations apply to all electrical and electronic equipment
sold within the European Union.

When you dispose of any electrical or electronic equipment, including SMART Technologies
products, we strongly encourage you to properly recycle the electronic product when it has reached
the end of its life. If you require further information, please contact your reseller or
SMART Technologies for information on which recycling agency to contact.

Restriction of Certain Hazardous Substances
(RoHS directive)
This product meets the requirements of the European Union’s Restriction of Certain Hazardous
Substances (RoHS) directive 2002/95/EC.

Consequently, this product also complies with other regulations that have arisen in various
geographical areas, and that reference the European Union’s RoHS directive.

Batteries
Batteries are regulated in many countries. Check with your reseller to find out how to recycle used
batteries.
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There are special regulations that must bemet when shipping a product that has a lithium ion battery
packaged with the product or shipping a lithium ion battery. When returning a SMART Technologies
product which contains a lithium ion battery or returning a lithium ion battery, call
SMART Technologies RMA for information on the special shipping regulations.

l 1.866.518.6791, Option 4 (U.S./Canada)

l 1.403.228.5940 (all other countries)

Packaging
Many countries have regulations restricting the use of certain heavy metals in product packaging. The
packaging used by SMART Technologies to ship products complies with applicable packaging laws.

Covered electronic devices
Many U.S. states classify monitors as covered electronic devices and regulate their disposal.
Applicable SMART Technologies products meet the requirements of the covered electronic devices
regulations.

China’s Electronic Information Products
regulations
China regulates products that are classified as EIP (Electronic Information Products).
SMART Technologies products fall under this classification andmeet the requirements for China’s
EIP regulations.
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SMART Technologies

smarttech.com/support

smarttech.com/contactsupport

http://www.smarttech.com/support
http://www.smarttech.com/contactsupport
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